<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>About MindNode</td>
<td>1</td>
</tr>
<tr>
<td>What is Visual Thinking?</td>
<td>2</td>
</tr>
<tr>
<td>How to Get Started</td>
<td>3</td>
</tr>
<tr>
<td>Document</td>
<td>8</td>
</tr>
<tr>
<td>Content</td>
<td>8</td>
</tr>
<tr>
<td>Styling</td>
<td>15</td>
</tr>
<tr>
<td>Outline</td>
<td>17</td>
</tr>
<tr>
<td>Workflow</td>
<td>19</td>
</tr>
<tr>
<td>Quick Entry</td>
<td>19</td>
</tr>
<tr>
<td>Sharing Documents</td>
<td>19</td>
</tr>
<tr>
<td>Automation</td>
<td>23</td>
</tr>
<tr>
<td>Printing</td>
<td>27</td>
</tr>
<tr>
<td>Touch Bar</td>
<td>28</td>
</tr>
<tr>
<td>Appendix</td>
<td>29</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>29</td>
</tr>
</tbody>
</table>
About MindNode

Requirements
In order to run MindNode for Mac, you will need a Mac running macOS Mojave 10.14.4 or newer. To view or edit your MindNode documents on an iPhone, iPod touch, or iPad, the device must be running iOS 12.2 or later with a copy of MindNode for iOS installed.

Backwards compatibility
With MindNode for Mac we introduced a new file format. MindNode will read the older file format and ask you to upgrade to the new format.

MindNode Plus
Starting with MindNode 7 you can unlock MindNode on iOS and macOS with a cross platform subscription called MindNode Plus (Find more information here.)

Free Editor
MindNode’s free version now allows you basic editing operations like adding nodes, reordering and folding. All feature that aren’t available in the Free Editor are greyed out and marked with a PLUS badge. MindNode Plus is available as a monthly or yearly cross platform subscription. (You can find more informations about MindNode Plus on our website.)

Languages
Supported Languages / Localizations
MindNode 6 is localized in 14 languages:

1. Arabic
2. Chinese - simplified
3. Chinese - traditional
4. Dutch
5. English
6. French
7. German
8. Italian
9. Japanese
10. Korean
11. Portuguese
12. Russian
13. Spanish
14. Swedish

The language MindNode uses is based on the system language you chose for your device. Should MindNode not be available in your native language it will be in English.

Support

If you have further questions, please don’t hesitate to contact us. You will find further information in our FAQs.

What is Visual Thinking?

Visual thinking is a collection of tools that allow you to collect, represent, link and organise thoughts to get a better idea of how they belong together. Mind mapping is one such tool. The most frequent structure is a central item surrounded by other items that split into more and more sub-items, similar to the branches in a tree. The depth of the structure is unlimited and each branch can contain as many sub-items and sub-sub-items as are necessary to represent a topic. The items are called nodes, with the central item called main node.

![Figure 1. Types of information](image)

Types of information to add

The node title is the most basic part of a node. It summarizes a thought in a few words. These words can be for example keywords, quotes, or questions.

Beyond this most basic building block, nodes can contain images. Images add visual representation of information and can be screenshots, photos, or graphics, like the Stickers that are included with MindNode.

To add more detailed information to a node you can add notes. These notes can contain longer explanations of concepts relevant to the key thought presented in the title of the node, or a list of thoughts that relate to your keyword.

Both node titles, as well as notes can contain links to online resources. They can be references
for resources and sources.

A node might also be a task, if you are planning a project and might contain space to check that off.

Lastly, if you are using a digital tool like MindNode, you can link a file to your node.

**Representing relationships between nodes**

There are two types of relationships on a mind map. The first one is the Parent-Child relationship, the second is the Cross-Connection.

**Parent-Child relationships** make up the main branch structure of your document. Each child is a sub thought, or aspect of its parent. The ultimate parent being, of course, the main node. One parent can have multiple children, though one child will always have just one parent. **Siblings** of one parent are united by an overarching theme to the thoughts represented. From the other side siblings can be seen as riffs off each other related to the parent thought. Sometimes children contain additional information to a parent. This is especially useful, if the thoughts are too important to hide in the notes section of the document. A number of children could, for example, contain several links to examples, or images of examples.

**Cross-connections** connect thoughts that are not directly related to each other in a hierarchy of thoughts, but are relevant to each other nonetheless. These might be two action items that are dependent on each other, or thoughts that would have fit well in either branch of your document. In real life terms you could say that these nodes should be dating each other.

**How to Get Started**

There are three stages to brainstorming with MindNode. Where you spend most of your time will depend on where you are in your creative process. The first step is collecting information and thoughts you already have. The second step is exploring how these items relate to each other and what needs to be added or researched. The third step is organising your thoughts and information into a coherent idea, or project plan.

Of course you will be cycling through the steps again and again. Organising what is there might show you a lack in a certain area, or realising a relationship will give you new thoughts to add.

At any time it is useful to just create a new main node to note down a thought, without worrying where it belongs. The beauty of working on a computer is that you can rearrange and reconnect information where it belongs at a later time, once the connections and structure becomes clearer to you.

**Outcomes**

Generally our users use MindNode in a wide variety of situations to solve many problems. At it’s most abstract, a document is a visual representation of how ideas relate. This can be for a
project like a website, or notes for a talk. You can use it to collect information on a topic of interest, or as a study guide. You can also use it to record the proceedings of a meeting, or to build an **outline** that you can then use with another application.

**Quick start into MindNode**

We will now guide you through creating your very first document.

1. **Open MindNode** in the Open Panel choose **New Document** to create your first **mind map**. You can also create a new document using the shortcut `⌘ + N`, or from the File menu.

![New Document](image)

**Figure 2. Click on the lower left corner**

2. The document starts with a first **main node**, ready for text to be added. Go ahead and add your first idea. If you are just playing around start with “study guide”. Exit the node by tapping the **canvas**. To create other **main nodes**, hit `↵` once, to leave the text editing mode, and then press `⌘ + ` to create a new **main node**. This will be ready to edit as well. Go ahead and enter a new idea, for example “exam”.

![Main Node](image)
3. To create a **sub-node** click on the plus sign on the right of the new **main node**. You can enter “multiple choice” here. You can also press ▶️ to create a **sub-node** to a **main node**. If you want to create a next level **node** press ▷️ and then ▷️, to create a grandchild.

4. Open the **Notes** tab by selecting the symbol in the top right corner. Go ahead and try that out. Add “fill the square”. As soon as you leave that field a small symbol on the right of a **node** will show that there is content in the **notes** section.

5. Now try adding an image or a file to your **node**. You can drag it directly from the desktop, or
from a Finder window. Or pick one of our **Stickers** when you click the **Sticker** button in the toolbar.

![Stickers in MindNode](image)

**Figure 5. Stickers in MindNode**

6. If you want to change the look of your map, open the **Theme** selection by opening the **Themes** sidebar on the right. Choose a **theme** by scrolling. You can apply it by tapping the selection.
7. One of the most helpful steps in visual thinking is getting to rearrange content. Click and hold on the first main node. Drag it onto the second main node and let go. It will now connect as a new child node.

8. To save your document press `Ctrl + S`, or select Save As from the File menu. We suggest that you save your file in iCloud Drive, so that it is easily shared to other devices you are using with the same Apple ID.

Now it’s time to create a new document.
Nodes

Nodes are the basic units of information in a document. Branches connect nodes and represent a hierarchical relationship. Another type of connections are cross-connections and tags. They show non-hierarchical relationships between nodes.

Basic Actions

To select a node click on it. You can also navigate around the Canvas using the Arrow keys.

To edit the title of a node double click it, or select it and press $\textbf{[Alt]}$. When you press $\textbf{[Alt]}$ again you leave edit mode. To add a line break, press $\textbf{[Alt]} + \textbf{[Enter]}$.

To create a new child node click on the plus symbol to the right of an existing node. It’s called the Node Well. Pressing $\textbf{[Alt]}$ creates a child node for the node you currently have selected. Pressing $\textbf{[Alt]} + \textbf{[Enter]}$ inserts a node between the selected node and its parent. You can also select this from the context menu when you click on a node. You can use $\textbf{[Alt]}$ to create a sibling for the node you currently have selected. Pressing $\textbf{[Alt]} + \textbf{[Enter]}$ creates a new main node. You can also select this from the context menu, when you click on the Canvas.

To delete a node simply press $\textbf{[Delete]}$. This deletes all children as well. If you want to remove the node and reconnect its children to its parent node press $\textbf{[Alt]} + \textbf{[Delete]}$.

Organizing Nodes

Sometimes it is necessary to reorganize nodes into new branches, as more information gets added to the document. This is the big advantage of digital visualisation tools compared to paper, it is very easy to do. To connect any node, even main nodes, to a new parent node click and drag it onto the new parent node. This will move it and all its children. They will assume the style of the new parent.

In the Preferences you can choose to deactivate this function so the node always keeps its current style. Deselect Inherit Style. To retain the existing formatting of the node and its children hold $\textbf{[Alt]}$ while reconnecting and having the preference set to Inherit Style.

Alternatively, if you want to shift a node up or down a level, you can use the $\textbf{[Alt]} + \textbf{[Up/Down Arrow]}$ to do so. If you want to shift the order of your nodes, you can simply drag the node to its new place relative to other existing nodes.

Alternatively you can use the $\textbf{[Alt]} + \textbf{[Left/Right Arrow]}$ to move a node relative to its siblings.

If you want to detach a node to create a new tree, you can select Detach from the Context menu.

Alternatively use the shortcut $\textbf{[Alt]} + \textbf{[Delete]}$.
**Folding and Unfolding Nodes**

When your structure gets more and more complex it is often necessary to hide parts of your map. This is also helpful when you are presenting information from your document.

The shortcut to fold or unfold a branch is `Esc + .`.

When you hold `Esc` and hover over a node, you will see an arrow with an ellipse that points toward the node. Clicking it will fold the node. A similar symbol will appear that shows that there are child nodes hidden under this one.

**Adding Content**

While a node title often contains the most crucial information as keywords, you will want to add additional information that adds context, detail, or helps you structure your document.

![Different types of content](image)

**Figure 8. Different types of content**

**Links**

To add a link to your node either type, or copy and paste an URL, including the http://. MindNode will recognize the URL and automatically make a link out of it.

If you don’t want MindNode to do so, you can disable Smart links in the Edit menu under Substituitions.

If you want to hyperlink text, you can select a phrase of the node title and select Add link from the Edit menu. Alternatively you can use the shortcut `Esc + K`.

**Notes**

Notes can contain long-form text, links to other documents, or unstructured thoughts.

Notes can be added from the Notes tab.
Another way to add notes is to select Show Notes Popover from the Context menu. This will open a Popover that you can also edit your notes in. To format the text in the notes you can use the Format menu, or the usual shortcuts. The shortcut `⌘ + ⌘ + k` will also open the Notes Popover.

In the notes you can also link relevant documents. Open the notes popover and use the Link button in the right lower corner to add a file. This will now show a preview of the file.
Note that the file is not imported into your document. An Alias is added for the file pointing to it's location on your hard drive. If you move the file, the link will not work anymore. Files are also not available to other users that you share a document with, or on your own iOS device.

The exception are images, which are imported into the document. You can choose to treat PDF files as images as well, by holding ⌘ when dragging them onto a node.

**Images & Stickers**

Images are stored directly in the MindNode document. MindNode accepts all formats compatible with your operating system and imports them as PNGs.

To add an image select a node and the image item in the tool bar. There is one for photos and one for Stickers. Clicking on Photo opens the system provided Photopicker. Next, drag the photo you want to add directly onto the node. You can also use Continuity Camera to import photos and scan documents using your iPhone or iPad. This is a great feature to e.g. attach pictures of slides when taking notes during a presentation. Open the context menu of the node you want to add the image to and select Import from iPad or iPhone from the menu. When you click on Sticker a drop down menu with your Stickers opens. Click the one you want to add. It will be added directly to your node. You can also search for the right sticker via the search bar.
In the **Stickers** menu you can select whether to add colored or tinted **Stickers**. **Stickers** will be tinted to match the current **node** color. To resize an image double click it. Left and right of it will now be round knobs. Clicking and dragging resizes the image. You can have **nodes** that only contain images.

In **MindNode** images by default are added above the **node** title. You can however change the image position. sidebar, there you’ll find the Image Position options.

When the Markup extension is activated on your Mac, you can edit images from within your document. Activate the extension in the **System Preferences > Extensions > Actions**. To use Markup in on your image select **Edit Image** from the Context menu. This will open the image in a new window. Once you are done click **Done** and the changes will be added to your document.

**Tasks**

When planning projects a **mind map** will often contain both ideas and **tasks** related to the goal. To differentiate between **node** items that require an action and those that do not, **MindNode** lets you assign a **task** to a **node**. These **tasks** can be checked off as you complete a **task**.
A **node** that has two or more **children** that were assigned **tasks**, will receive a Progress tracker that will be marked completed, as you check of the sub-**tasks**. If you check-off the Progress tracker of the **parent**, all **child nodes** with **tasks** will also be marked complete. **Only child nodes** can have **tasks**.

To assign a **task** for a **node**, go to the Node menu. Any **children** will automatically become **tasks** as well. A **parent node** can have both **task** children and **non-task** children.

Alternatively you can assign a **task** by using the shortcut **⌘ + T** on a selected **node**.

### Connections

The basic relationship between items in **MindNode** is hierarchical. To show relationships between items that are not in a hierarchical relationship you have the option to create **connections**.

You can select **Create Connection** from the Context menu. Then click the **node** you want the **connection** to go towards. You can also hold **⌘** and then drag from one **node** to another to create a **connection**. Or use the toolbar item

To add a label to a **connection** select **Edit Title** from the Context menu, or double click on the the **connection** way point.

Regardless of layout selection you can determine the curvature of a **connection** by grabbing the waypoint knob in the middle and dragging it. To straighten the **connection** double click the
waypoint.

Should you want a clear look on the hierarchical order with less distraction you can also hide all cross connections. Therefore in the main menu on top of your screen under View click ‘Hide Connections’. In the same way you can also reshow them again. If you close a document with hidden cross connections and reopen it the cross connections will also be shown again.

**Visual Tags**

Another way to show nonhierarchical relationships are visual tags. They help you categorize your ideas and add more context to your thoughts. Use tags to prioritize ideas and bring focus to a related group of ideas that are otherwise not connected.

![Figure 14. Visual Tags](image)

**Create & Edit**

To create visual tags open the Tags sidebar and then tap the + in the upper left corner of the sidebar. Now add a title to the tag. To change the color of the tag click its color icon. The color of existing tags can be edited again the same way. To edit the name of an existing tag right click the tag and select Rename from the context menu. Right click on a tag and from the context menu select Delete to delete a tag.

**Apply & Remove**

In order to add a tag to a node select the node and then double click the tag the Tags sidebar. You can remove the tag from the node the same way. Another option to remove at tag from a node is to select the node, then click the tag there and remove it via the popover by clicking the tag icon there.
Highlight

Using our tag-highlight mode you can focus on selected tags to discover new connections. To highlight a certain tag click the highlight icon next to it the Tags sidebar. End the highlighting by clicking it again. This also works directly on the node via that popover. When tag highlighting is activated MindNode by default displays the union of all tags selected for highlighting. This behaviour can be changed to only show the intersections of those highlighted tags in the upper right corner of the Tags sidebar.

Focus Mode

Big mind maps sometime can be distracting. Here is were Focus Mode helps you by fading out all branches but the one you are working on. It can be entered via the Focus Mode button in the toolbar or with the shortcut $\textasciitilde + \# + F$. If you want to change the area you are focusing on you can click the faded out node you want to focus on next and select Refocus from the appearing menu.

Styling

Canvas

The Canvas includes your entire document. Think of it like you are a painter without the limits to the base of your painting. You will find the styling options for your Canvas in the Themes Inspector on the left.

Layout

The most important decision for the readability of your document is certainly the layout. The arrangement of your information determines how easy it is to comprehend what is there. We have two branch styles, curved and orthogonal that you can apply to a map. We also have the option for a layout that is vertical or horizontal. These can be applied individually for each main node.

Smart Layout

Smart Layout automatically arranges your nodes in a compact, easy to read layout. To have branches on only one side, or on both sides you can grab and move them across. If you want to have a balanced document you can choose to Balance Nodes in the Node Menu under Organise.

Manual Layout

If you want a different node alignment, you can also select Manual Layout.

MindNode will still shift your nodes slightly so they do not overlap each other. If you want control over this too, you can de-select this in the Preferences, uncheck the option Prevent
node collisions in manual layout.

If you want to take advantage of our Smart Layout algorithm for just one branch of your map, you can select the parent of that branch and then select Reorganize Nodes from the Organize menu in the Node menu. Alternatively you can use the shortcut ⌘ + ⌘ + R.

Themes

To make creating visually appealing mind maps as easy as possible, MindNode provides themes.

You can find the themes in the Theme panel scroll through the themes and when you find the one you want to use double click. Theme settings get synchronised via iCloud between MindNode on macOS and on iOS.

Personal Themes

To create your own themes, create a new document with a main node, six child nodes and one connection. Set the colors and font to your liking, then select `Add Theme > Extract Theme` This will save the style and it will now be available in the theme selection, where you can also choose a new name.

Figure 15. Personal theme layout

You can add existing themes and share your own themes with others. Click the gear icon underneath the theme for more options.

Background

You can choose to change the background color of your canvas at the bottom of the themes panel.

Style

Next to the global settings like theme and layout you may want to style individual nodes, or branches to show their particular significance. You can do this in the Style tab. Changes are
always applied to all selected nodes

The options are to change the node's width and shape, fill color, and border (including line type, thickness and color). Per default node width is set to automatic. The nodes adapt to the width of the node title, with a maximum around 320pt. In the Preferences you can deselect Shrink node width to fit content, if you prefer to have manual width as your default. For the branch you can select line type, color and thickness. Per default Auto-Decrease Branch Thickness is selected. You can deselect this to choose your own branch thickness.

When reconnecting a node you may want it to inherit the style of the new parent. You can set this as default in the Preferences. To keep a nodes current style intact despite the setting hold ⌘ while reconnecting.

For connections you can choose end point styles, both in the origin and at the finish, line style, thickness and line color. The label will have the same color as the connection.

**Outline**

When working on a document, it can sometimes be helpful to view the structure in a linear mode. To do this MindNode has an integrated Outline view. You can toggle the Outline view in the top left corner of your document window.

![Figure 16. Outline View](image)

In your Outline the first level nodes around your main node will be sorted clockwise. Each level of sub nodes thereafter will be displayed in a top down manner.

Nodes that are folded in your map will be folded in your Outline. This is signified by a minus sign at the end of the branch.

Tasks and super-tasks are shown to the right of the Outline in their current state of completion.
Notes are signified with the same symbol as in the map. Clicking the notes symbol opens the pop over in the map. Stickers are shown in the Outline, attached images will appear as a symbol. Selecting a node in the Outline will also select that node on your canvas and automatically refocus your canvas so it is visible.

Settings
You can find the settings at the top of the Outline, next to the Search bar. From the settings of the Outline you can select to Wrap node titles, to show all of the title in your Outline, and Show only open tasks if you want to use the Outline as a todo-list.

Search
You can search node titles using the Search bar atop the Outline.

Editing Nodes
You can delete a node by dragging left with two fingers on your trackpad until the Delete button appears. This will delete just that node. Its children will be reconnected to its parent.
Quick Entry

On the Mac you can activate the Quick Entry menu bar item in the Preferences. There you can also record a shortcut, which allows you to directly open QuickEntry at any time.

To start a new document, or take notes, click on the icon. Hit Enter to start a new line with a new item. This will be indented as a sub-node to the first icon. To remove the indentation hit Enter again. You can use Tab to indent further.

Use the tool bar items to indent, add tasks, tags and notes. Note: Tags will only be detected as such on the end of a node title.

When you close Quick Entry your notes are saved.

To create a document click the Create Mind Map button at the bottom. This will create a new document for you.

Sharing Documents

Most likely MindNode is part of a workflow for you, rather than a one stop destination. That is why MindNode enables using the information you structured in a mind map in other apps.

Import/Export

MindNode is able to import and export a number of file formats for use within other apps:
Import & Export

• FreeMind (supported by most mind mapping apps)
• OPML (supported by most Outliners and many mind mapping apps)
• CSV (Spreadsheets apps)
• Plain Text (all text editors)
• RTF (most text editors)
• Markdown (Markdown editors)
• TextBundle & TextPack (Learn more)
• Single File MindNode

Import only

• Mindjet MindManager
• iThoughts

Export only

• Docx (only supported on macOS)
• PNG
• PDF

Be aware that some features, like MindNode’s connections, may be lost when moving mind maps between different applications. It is worth noting that OPML files do not retain formatting of text. In text files (.txt and .rtf) each node level is indented using a Tab.

To import a document in a compatible format simply select the document from the Open dialog via the File menu. Go to the File menu and choose Open, or press ⌘ + 0.

To export a document click on Export To in the file menu, select your preferred file format in the panel and then click Export. The following panel lets you save your new file as usual.

You can also share the exported file directly to Mail, iMessage, or AirDrop by clicking the Share button in the bottom left.

Sharing

To share a MindNode file via Mail, iMessage, Reminders or AirDrop to another device, click the share button in the top right corner of your document window and select your option.

In Mail and Messages a new message will be opened and the file added as an attachment.
AirDrop

AirDrop allows you to wirelessly send documents to compatible devices using a Bluetooth connection. Please make sure that Bluetooth is enabled.

To send a *MindNode* document via AirDrop to another device, click the share button. From the share menu choose AirDrop. Please make sure the receiving end is in receive mode, and select the device you want to send a document to.

To go into receiving mode on *iOS* devices please bring the Control Center forward, by sliding from the bottom upwards.

To go into receive mode on a *Mac* please go to the Finder and open a new window. Now choose Go > AirDrop from the menu.

Tasks

Once you have completed your project planning you might wish to use your *tasks* as a list. *MindNode* offers integration with Reminders for *tasks*, and sharing to Things and OmniFocus. You can import and export TaskPaper documents into *MindNode*.

In the Sharing menu you will find the option to export to Reminders. This will create a new list in the Reminders app. The title of the list will be the name of your Document. When you check items complete in either Reminders or *MindNode*, the completion will be synchronized across both.

To update your list with new *tasks* you have added, or changed *task* titles, export the list again. New items will be added and titles will be updated.

1) Deleting items in Reminders, or in your *MindNode* document will not delete the items in the other. Only *task* completion is synchronized. Similarly editing task titles will not be synchronized.

2) Only *tasks* will appear in the Reminders list, not their parent *nodes*. The *branch* path will be added as a note to the *task* above the note imported from *MindNode*.

Sharing to Things, OmniFocus and TaskPaper will create a new list for you. These do not, however, update automatically with changes you make to your *MindNode* file.

Tags

When exporting documents from *MindNode* to other file formats, *tags* may be formatted differently compared to MindNode, depending on what the specific file format supports. When importing other file formats into MindNode, *tags* are also imported.
Please note that FreeMind, iThoughts, and older versions of MindNode do **not** support **tags**.

**Tags in text formats**

Text file formats like Plain Text, RTF, Markdown (including TextBundle & TextPack), or Microsoft Word (Mac only) use the **CamelCaseHashtag** format. TaskPaper uses the same format, but with `@` instead of `#` as the prefix. Also, `@done` is not treated as a tag, but as a marker for completed **tasks**.

When exporting, the **tags** are added after each nodes' title. For example, an exported line may look like this: “This is the node title #Tag1 #Tag2”

When importing, any **tags** in a line are added to the imported node and trailing **tags** are dropped from the node title. For example, “This is an #Important node #Awesome” will be imported as a node with title “This is an #Important node” and the tags “Important” and “Awesome”.

**Tags in other file formats**

- **CSV**: **Tags** are in a separate column at the end called “tags”. In that column, multiple **tags** are separated by commas.
- **OPML**: Uses the same format as text formats above, i.e. **tags** are added in the format `#CamelCaseHashtag` at the end of each node title.
- **XMind / XMind Zen**
- **Mindjet MindManager**

**Tags in task lists**

- **Reminders**: **Tags** are added as a comma-separated list in the notes field of each reminder.
- **OmniFocus**: Uses the TaskPaper format for export.
- **Things**: Please note that Things only imports **tags** that you have previously added in Things manually. Also, Things only supports **tags** in To-Dos, not in Headings. That means only nodes that do not have child nodes in **MindNode** will have their **tags** exported to Things.

**iCloud Drive**

If you are using **MindNode** on multiple devices and want to keep your files up to date on all devices, use iCloud Drive to sync changes seamlessly. Make sure iCloud Drive is activated in the System preferences.

When saving a new document make sure to save it in the **MindNode** folder inside iCloud Drive. All changes you save will now be saved to iCloud Drive and available on all connected devices.
**Automation**

Using Apple Script or URL Schemes you can automate certain recurrent tasks and make MindNode part of a larger workflow. Automation requires advanced knowledge and is only recommended for power users.

**AppleScript**

Apple Script allows you to write scripts that batch export document in all supported formats. We are currently supporting the following export types via Apple Script:

<table>
<thead>
<tr>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>MindNode</td>
</tr>
<tr>
<td>MindNode’s Single File Format</td>
</tr>
<tr>
<td>FreeMind</td>
</tr>
<tr>
<td>OPML</td>
</tr>
<tr>
<td>CSV</td>
</tr>
<tr>
<td>TaskPaper</td>
</tr>
<tr>
<td>Markdown</td>
</tr>
<tr>
<td>DocX</td>
</tr>
<tr>
<td>PDF</td>
</tr>
<tr>
<td>PNG</td>
</tr>
</tbody>
</table>

As an example we created a script to take all OPML files from a folder and export them as PDF.
set folderPath to choose folder
set fileExtension to "opml"
tell application "Finder"
    try
        set the fileList to files of folderPath whose name extension is fileExtension
    end try
end tell
tell application "/Applications/MindNode.app"
    repeat with mindNodeFile in fileList
        open (mindNodeFile as alias)
        set mindNodeDocument to document 1
        set fileName to POSIX path of (mindNodeFile as alias)
        set baseName to (characters 1 thru -((count of fileExtension) + 3) of fileName) as string
        set exportFile to ((baseName & ".pdf") as POSIX file)
        tell mindNodeDocument to export to exportFile as PDF
        close window 1 without saving
    end repeat
end tell

URL Schemes

**URL schemes** are special formatted URLs that allow to automatically perform actions in **MindNode** and other apps. All **URL Schemes** start with **mindnode://** followed by an action. If you don’t provide an action, **MindNode** is simply launched.

Usage:

```
mindnode://
```

Create New Document

Action: newDocument

This action creates a new document in the default storage location. Normally this is the **MindNode** iCloud Drive folder. You can change the default storage location in the Settings app under **MindNode**.

Usage:
Open Document

Action: open

Using the open action you can open an existing document. Open supports several parameters that will help point to the correct document and we recommend you use the feature in MindNode to automatically create the URL: With a document open, click on the share icon in the upper right corner of the MindNode window and select 'Copy URL Scheme' to copy it to the clipboard. You can now paste this URL into a text or URL field and triggering it will automatically open the MindNode file.

Name & Path Parameter:

```
mindnode://open?name='name'&path='path'
```

name: Name of the document. If your document name contains spaces, you need to replace them with %20.

path: This is an optional parameter, which is only needed if the document is in a subfolder. MindNode tries to find the document in the iCloud Drive folder or the MindNode "On my iPhone/iPad" folder.

Usage:

- mindnode://open?name=todos
- mindnode://open?name=my%20next%20presentation
- mindnode://open?name=notes&path=meetings

URL & Bookmark

```
mindnode://open?url='url'&bookmark='bookmarkData?'
```

url: A URL to the document. The URL needs to point to a document in MindNode's iCloud container. Otherwise the system won't grant permission to access the document.

bookmark: An optional parameter that is only used when you use the built-in action to create a "File URL Scheme"
Import Document

Action: import

Imports a document using one of the supported import formats.

Parameters:

```
mindnode://import?format='format'&name='name?'&content='content?'
```

- **Format**: A supported export format. See list below
- **Name**: This is an optional parameter. It will be used as the title for the document.
- **Content**: This is an optional parameter. When it’s provided it will be imported into the document. Otherwise we will look on the clipboard for the data.

Import Formats:

- CSV (format='csv')
- PlainText (format='txt' or 'text' or 'plaintext')
- RichText (format='rtf' or 'richtext')
- MarkDown (format='markdown' or 'mdown' or 'md')
- OPML (format='opml')
- Freemind (format='freemind')
- TaskPaper (format='taskpaper')

Launch Quick Entry

Action: quickEntry

Launches **Quick Entry** and adds the provided text as the content.

Parameters:
Open Preferences

Action: preferences

Open MindNode's preferences.

Usage:

```
mindnode://preferences
```

Printing

In addition to your usual print settings there are a number of options related to printing your MindNode document. Click Show Details and you will find this in the bottom right quarter of the print dialog. Select MindNode from the drop down menu.

First you can decide to print your document either as a mind map, or as an Outline.

When you are printing a map you can decide to scale your map, or to fit it onto one page. When selecting the former option your document may be printed on several pages, depending on the size of your map.

You can also select to print your canvas as is, or to print each main node onto a separate page.

When printing an Outline, you can choose to print your map with, or without, notes. You also have a choice to unfold all nodes, or to print with the nodes that are currently folded on your canvas folded in the print out as well.

Below the selection for Map or Outline you can select to print in either Full color, or Grayscale.

Further options include adding the filename and/or a date in the header and a page number at the bottom. Page numbers are include in the format Page 1 of 10. The filename is included on the top left of your page and the date on the top right.
Touch Bar

On supported MacBook Pro’s you can also use the Touch Bar to interact with the document.

Bars

The content of the Touch Bar changes based on selection. At the moment we use four different bars.

1. Canvas

When the canvas is selected you can toggle the sidebars, change the background color and create a new mind map.

2. Nodes

When a node is selected you can add Tasks, add Notes, toggle folding and create new nodes.

3. Edit Mode

When editing the title of a node, the Touch Bar displays the same controls as when a node is selected, but both bars can be configured individually.

4. Cross Connection

When a cross connection is selected you can add a label or reset the waypoint using the Touch Bar.

Customize

The Touch Bar is fully customizable. For example you can add buttons to toggle the sidebars on all bars or change the order of existing buttons. To customize the Touch Bar select View > Customise Touch Bar... from the main menu.
Appendix

Shortcuts

Legend

- Escape
- Shift
- Control
- Alt/Option
- Command
- Enter
- Tab
- Space
- Arrow Keys

Node Creation

- Create New Child Node
- + Create New Parent Node
- Create New Sibling Node
- + Create New Sibling Node Above Current Node
- + Create New Main Node

Edit Node

- + Edit Node Title
- + Add Link
- + Open Link
- + Size to Fit Content
- + Add/Remove Task
- + Check/Uncheck Task

Navigation

- + ? Zoom in
- + Zoom out
- + Zoom to Actual Size (100%)
- + Zoom to Fit
Appendix

+ +  Zoom to Selection
+ R  Go to Main Node
+ + R  Center Selection
+ + =  Lock Viewport on External Screen
+ + →  Scroll Canvas Right
+ + ↓  Scroll Canvas Down
+ + ←  Scroll Canvas Left
+ + ↑  Scroll Canvas Up

Folding
+  Fold/Unfold Branch

Connections
+ L  Create Cross Connection
+ + L  Show Start Node of Cross Connection
+ + L  Show End Node of Cross Connection
+ + L  Reset Waypoint of Cross Connection
+ + + L  Hide All Cross Connections

Focus
+ + F  Enter/Exit Focus Mode

Node Selection
+ Move in → Direction
+ Move in ↓ Direction
+ Move in ← Direction
+ Move in ↑ Direction
+ + Select Next Node in → Direction
+ + Select Next Node in ↓ Direction
+ + Select Next Node in ← Direction
+ + Select Next Node in ↑ Direction
+ A  Select All
+ + A  Deselect All
Appendix

Select All Child Nodes

Forward Cycle through Main Nodes

Backward Cycle through Main Nodes

Move Node Selection

Move 1pt in → Direction

Move 1pt in ↓ Direction

Move 1pt in ← Direction

Move 1pt in ↑ Direction

Move 20pt in → Direction

Move 20pt in ↓ Direction

Move 20pt in ← Direction

Move 20pt in ↑ Direction

Organize Nodes

Reorganize Nodes

Balance Nodes

Move All Nodes to the Right/Bottom

Move All Nodes to Left/Top

Sort Nodes by Task State

Sort Nodes Alphabetically

Detach Node

Search

Find

Find & Replace

Find Next

Find Previous

Sidebars, Pickers & Popovers

Show/Hide Toolbar

Show Sticker Picker

Show Photo Picker
Appendix

Show/Hide Style
Show/Hide Themes
Show Notes Popover
Show/Hide Notes
Show/Hide Tags
Show/Hide Outline

Edit Mind Map

Delete
Delete Single Node
Cut
Copy
Copy Single Node
Copy Style
Paste
Paste Style
Paste and Preserve Style
Duplicate
Duplicate Single Node
Undo
Redo

Text Formatting

Toggle Bold
Toggle Italic
Toggle Underline
Toggle Strikethrough
Increase Font Size
Decrease Font Size
Show Colors
Align Left
Align Centered
Align Right
Appendix

Document

Kernel + T Show Toolbar
Kernel + : Show Spelling & Grammar
Kernel + ; Check Document Now
Kernel + E Export
Kernel + N New
Kernel + O Open...
Kernel + W Close
Kernel + W Close All Documents
Kernel + F Enter/ Leave Full Screen
Kernel + M Minimize
Kernel + M Minimize All
Kernel + H Hide App
Kernel + H Hide Other Apps
Kernel + S Save
Kernel + S Save As...
Kernel + S Duplicate
Kernel + P Print
Kernel + Q Quit App
Kernel + Q Quit and Keep Windows
Kernel + P Page Setup...
Kernel + ^ Show Previous Tab
Kernel + Show Next Tab
Kernel + Show All Tabs
Kernel + ? Open User Guide
Kernel + ? Get Support
Kernel + Show Quick Look
Kernel + Preferences...

Gestures

Touch gestures are features that are almost impossible to discover, but they can be hidden gems that make interacting with an app much more powerful.
The following gestures are available in **MindNode for Mac**

- Force touch on the canvas to create a new main node (Magic Trackpad 2 only)
- Force touch on a node to bring up the note popover (Magic Trackpad 2 only)
- Press ⌘ and hover the mouse on the Node Well, it will change to the Folding indicator
- Press ⌘ and drag a node on another, the node style will be retained when 'Inherit Style' is selected in the Preferences
- Press ⌘ and drag & drop a PDF on a node, the PDF will be imported as an image
- Press ⌘ and drag from one node to another to create a cross connection
Copyright © 2020 IdeasOnCanvas GmbH. All rights reserved.

MindNode is a trademark of IdeasOnCanvas GmbH.

3D Touch, AirDrop, AirPlay, AirPrint, Apple, the Apple log, Apple Pencil, AppleScript, Apple TV, Apple Watch, Finder, Handoff, iPad, iPhone, iPod touch, Mac, MacBook Pro, macOS, Multi-Touch and Touch Bar are trademarks of Apple Inc.

App Store, iCloud, iCloud Drive are service marks of Apple Inc.

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.